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INTRODUCTION

This tutorial covers the following:

e Creating an AVR® assembler project within Microchip Studio
e Simulating an assembly program with the software debugger built into Microchip/Atmel Studio
e Running an assembly program with the debugger/programmer built into your pPAD.

The appendix of this document identifies how to do the above with the C programming language. When using C
across a network (which most of you will probably NOT do), you will need to perform the additional steps laid out
in the last page of this document.

For more information on Microchip/Atmel Studio, visit the Microchip/Atmel Studio 7 User Guide.

KNOWN ISSUES

If a filename or path has a space or special symbol, Microchip Atmel Studio often will fail. Solution: Remove the space or
special character.

REQUIRED MATERIALS
e  GPIO_Output.asm
e uPAD v2.0 with USB A/B connector cable

SUPPLEMENTAL MATERIALS
e uPAD v2.0 Schematic

PROCEDURE

This tutorial assumes that you already have Microchip Studio installed. If not, read the Microchip Studio Installation
Instructions.

Creating the Project
1. Open Microchip Studio and create a new project via File > New > Project as shown in Figure 1.

File | Edit View VAssistX ASF  Project Debug Tools Window Help

New P Project. Ctrl+Shift+N
Open P File. Ctrl+N
Close As Atmel Start Project

Close Solution As  Atmel Start Example Project

Import v | WebMCC Project

Save Selected Items Ctrl+S & Example Project.. Ctrl+Shift+E

Figure 1: Navigating to Project Creation.

2. Under Installed, select Assembler, and then AVR Assembler Project as shown in Figure 2.

MNew Praoject 7 >
I Recent Sort by: Default - i i= Search Installed Templates (Ctrl+E) P
4 |nstalled Type: A bl
. AVR Assembler Project Assembler ype: Assemiler
C/C++ Creates an AVR. 8-bit Assembler project

Micrechip Studio Solution

Figure 2: Selecting the Project Type.


https://www.microchip.com/content/dam/mchp/documents/atmel-start/Atmel-Studio-7-User-Guide.pdf
https://mil.ufl.edu/4744/examples/GPIO_Output.asm
https://mil.ufl.edu/4744/docs/uPAD/schematics/uPAD_v2.0_schematic.pdf
https://mil.ufl.edu/4744/docs/Install_Microchip_Studio_7.0.pdf
https://mil.ufl.edu/4744/docs/Install_Microchip_Studio_7.0.pdf
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3. Browse to a desired location for which to save the file (using the Location textbox) and save the file with
a meaningful name as shown in Figure 3. For this tutorial, we will call the project “GPIO_Output”.

Mame: |GPIO_Output |
Location: ChAtmel Studic\Project Creation Tutorial', 2
Selution name: GPIO_Cutput Create directory for solution
| OK Cancel
Figure 3: Project Creation.
4. In the Device Selection window that
automatically opens, select the correct | === =
device and click OK, as shown in i @ ) [ -~ 3
Figure 4. For the entirety of this Marne App.Boot Memory (Kbyles] Data Memory (bytes]EEPROM [bytes) | Device info:
. . | TR T 0162 L 1
semester, we will be using the |%nsEmi e o o
ATxmegal28A1U. You should now
see a workspace like what is shown in
Figure 5.
il
.

Figure 4: Selecting the Device Configuration.

; GPIO_Output.asm

H
; Created: 12/21/2025 2:19:53 PM
; Author : logan

; Replace with your application code
start:

inc ril6

rjmp start

Figure 5: Microchip Studio Workspace.
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Creating and Simulating the Program

We will be using the code from the GPIO OQOutput.asm file. This program utilizes a GPIO (General-Purpose
Input/Output) port connected to the RGB LED package on your uPAD. As shown in Figure 6, these LEDs are
connected to Port D, the GPIO port we will be utilizing throughout this program

33 +5W

30k 30k R0
Ri4 R105 160

103 1004
EMUS EMUS

(PD4) _m_._l |
+5
GMD GND E;
thg e
(PDS) _GRFFNPWH — EEEJ

100 A
(po6) _BITE_PUH w

Figure 6: RGB LED package as shown on the uPad Schematic.

A GPIO port can be defined in many capacities, though in the context of this tutorial, it suffices to relate a GPIO
port with a group of physicals pins controlled by electrical signals, i.e., a low voltage signal corresponding to a
binary ‘0’, a higher voltage corresponding to a binary ‘1°.

1. Copy the code from the accompanying GPIO_OQOutput.asm file to your main program. Save the main program
by navigating to File = Save main.asm, or by pressing Ctrl+S (i.e., Ctrl and then S) on your keyboard.
Alternatively, save all aspects of the project by navigating to File 2 Save All, or by pressing Ctrl+Shift+S.

2. Build the project solution by navigating to Build = Build Solution (or by using the function key F7). If your
code has no errors, the Output window at the bottom should include “Build succeeded” as shown in Figure 7.

Done building target "Build" in project "GPIO_Output.asmproj".
Done building project "GPIO Output.asmproj".

Build succeeded.
========== Build: 1 succeeded or up-to-date, @ failed, ® skipped ==========

Figure 7: Build Success.

NOTE: We suggest enabling line numbers in the code editor. Navigate to Tools > Options = Text Editor > All
Languages and select Line Numbers, under the Settings heading, as shown in Figure 8.


https://mil.ufl.edu/4744/examples/GPIO_Output.asm
https://mil.ufl.edu/4744/docs/uPAD/schematics/uPAD_v2.0_schematic.pdf
https://mil.ufl.edu/4744/examples/GPIO_Output.asm
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Options ? *
Search Qptions (Ctrl+E) p  Statement completion
Auto list members
Quick Launch ~ & -
Startup [m] Hide advanced members
Tabs and Windows [“] Parameter information
Task List Settings
_WEb e [ Enable virtual space
I» Projects
I Source Control [ Word wrap
4 Text Editor Sh ual glyphs for word wrap
General
File Extension Enable single-click URL navigation
I» All Languages o
b Assembler Dﬂa\rlgatlon bar
I GCC [m] Automatic brace completion
b Plain Text [ Apply Cut or Copy commands to blank lines when there is no selection
I XML
b Debugger MNote: This page sets options for all languages. To change options for only one
I Atmel Software Framework w language, select the desired language from the tree on the left.

Figure 8: Enabling Line Numbers.

NOTE: If your compiler detects any errors or warnings, you can double-click on an individual listing of either type
and your cursor should be brought to the offending line (sometimes, your compiler cannot associate the error or
warning with a specific line of code).

NOTE: Within the assembly file code editor, press Ctrl+Space on your keyboard to bring up a dialog box consisting
of a list of assembly instructions for the currently chosen device. If any string of letters is typed into this dialog box,
the listings shown will start with that specified string of letters. The internal program used for this function is
sometimes known as Intellisense, Autocomplete, or Auto Completion.

Before we can execute the program, we must select the appropriate debugging tool in A¢mel Studio. For simulation,
we will select the software simulator built into Atmel Studio.

3. Click the target selector icon as shown in Figure 9. This will open the project Tool window. You can also
navigate here via Project = <Project_ Name> Properties...
Bl e - B _ o ATemegal28ATU . § Simulator _

main.asm H# X ASF Wizard

ie "ATxmegal28AlUdef.inc”

Figure 9: Target Selector.



University of Florida EEL 4744 Dr. Eric M. Schwartz
Department of Electrical & Computer Engineering 29-Dec-25

Page 5/10 CREATE, SIMULATE, DEBUG, AND RUN PROGRAMS IN
MICROCHIP (ATMEL) STUDIO

Revision 0

4. Under Selected debugger/programmer, use the dropdown menu to select Simulator as shown in Figure 10. The
target selector icon should now display Simulator. Finalize these changes by saving the project (File 2 Save
All) and then close the project properties window.

GPIO_Output & X main.asm ASF Wizard

Build
MN/A N/A
Build Events

Toolchain

Selected debugger/programmer
Device

Simulator

Packs

Advanced

Figure 10: Selecting the Debugger.

Before executing the program, we will place a breakpoint. Breakpoints halt your program immediately before
executing the instruction specified at the breakpoint.

Note: Later in the course, certain functions cannot be debugged via breakpoints and must be handled with
alternative methods (like LED indication).

5. Place a breakpoint in your code editor on the first assembly instruction within your main program:
1di R1l6, BIT456, by using your mouse to click the pane to the far left of the instruction. A red dot will
appear next to this specified instruction, as shown in Figure 11.

Project Build Debug Tools Window Help
QEW XA 9- & b o Dby - ]
-] k Hex & Gg -~ - - A ) _ A ATemegal28AIU T Simulator _

GPIO_Cutput mainasm +# X ASF Wizard
"ATxmegal28AlUdef.inc”

BITA = 8beee1sese
INVA - 8b11101111
RED = INV4

BITS - 6bBA1608008
INVS = ~BITS

GREEN = ~(BITS)

BIT6 - x40

BLUE = ~(BIT6)
BIT456 = Bx78

BIT64)

BLACK = @xFF

MAIN

axelee
MATN:

1di r16, BIT456
PORTD DIRSET, rilé

Figure 11: Breakpoint at first instruction of the given program, along with the debug Continue icon.
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6. Start debugging the main program. To start debugging, select the Start Debugging icon shown in Figure 12,
navigate to Debug - Continue, or simply press F5 on your keyboard. The break pointed line of code will be
highlighted, following a yellow arrow in the gray pane where the breakpoint resides. This indicates the next
instruction to be executed.

File Edit View

0-0 B-A L -NWMHE XAH D - % b bl Debug -

X ASF  Project Build Debug Jools Window Help

Bl » oo L Hae 9 g~ - LA

GPIO_Qutput main.asm = X ASF Wizard

Figure 12: Starting Simulation.

7. While debugging, you can view any of the processor’s registers, I/O ports, memory locations, etc.; a very
powerful tool when writing embedded software. Open the I/O view by navigating to Debug = Windows 2>
/O, as shown in Figure 13.

roject  Build  Debug

e ! Windows Breakpoints
[P + o @ Data Breakpoints
rocessor Status

GPIO_Output main.asm
B Stop Debugging Ctrl+Shift+F3
"ATxmegal28AlUdef.inc” = ve Watch
Program Counter Trace
BIT4 = @beeeleoee P Continue 5 Output

Figure 13: Opening the I/O view.

8. Open the Processor Status view by navigating to Debug = Windows = Processor Status. Your screen should
now resemble Figure 14. It is likely available by default.

File Edit View sist{  ASF roject  Build Debug Tools
il il Windows Tl Alt=F3
Data Breakpoints

Processor Status

GPIO_Output main.asm

B Stop Debugging Ctrl+Shift+F5

Figure 14: Opening the Processor Status Window.
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9.

Program File, Processor Status, Watch, and Memory.

Figure 15 shows a standard debug view with the four generally most useful (and the default) windows shown:

ﬂ GPIO_Output (Debugging) - Microchip Studio
File  Edit View VAssistX Project Build Debug Tools Window
TR

e v 2t n TlHx B @

Help

Debug Browser ~

o0 B

.| >

f25_AM_GPIO_Output.asm

.equ INV4 = 0bl1101111
.equ RED = INV4

.equ BIT5 = 0boo100000
.equ INV5 = ~BIT5

.equ GREEN = ~(BIT5)
.equ BIT6 = 0x40

.equ BLUE = ~(BIT6)
.equ BIT456 = Ox70
.equ WHITE = ~(BIT456)
.equ BIT64 = 0Ox50

.equ PINK = ~(BIT64)
.equ BLACK = OXxFF

; Any necessary initializations for SRAM in data space?

.ORG ©
;Skip address through ©x@0FD (interrupt vectors)
) rjmp MAIN
;Start program at 0x0100 so we don't overwrite vectors (©-0x00FD)
.ORG 0x0100
MAIN:
126% < 4 ) B
Watch 1
Name Value Type Memory:  prog APP_SECTION
S o lbyelregistersi@R16 prog 0x000000 F co £f
@7 0 byte{registers)@R17 prog 0x000010 ff £f £f
@8 0 byte{registers)@R18 prog 0x000020 £ Ff £f
@7 0 dword@Z prog 0x000030 ff ff ff
@y 0 dword@Y prog 0x000040 ff ff ff
prog 0x000050 ff ff ff
prog 0x000060 ff ff ff
prog 0x000070 ff ff ff
prog 0x000080 ff ff ff

Autos Locals RUEIEIE Watch 2 W8 Memory 4

Stopped

£
£
£
£
£
£
£
£

Advanced Mode Y Quick Launch (Ctrl+Q) Pl - (m] X
|p while '|mﬁ;;
ATxmega128A1U Simulator -
GPIO_Outputasm # X v |Processor Status v I X
= Name Value
-
Program Counter ~ 0x00000000 -
Stack Pointer OX3FFF
X Register 0x0000
Y Register 0x0000
Z Register 0x0000
Status Register DOEVNG
Cycle Counter 0
W Frequency 1.000 MHz
Stop Watch 0.00 ps
= Registers
ROO 0x00
RO1 0x00
RO2 0x00
RO3 0x00
RO4 0x00
RO5 0x00
RO6 0x00
RO7 0x00
RO8 0x00
RO9 0x00
R10 0x00
1/0 LGRS Solution E...  Properties
ff ff £ff £ff £f £ff £ff £f £f £f £f ff -
ff ff £ff £f £f ff £ff £f £f £f £ff ff
ff ff ff £ff £f ff ff £f £f £f ff ff
ff ff ff £ff £f £f £ff £f £f £f £ff ff
ff ff ff £ff £f ff ff ff £f £f ff ff
ff ff ff £ff £f ff ff £f £f £f ff ff
ff ff ff £ff £f ff ff £f £f £f ff ff
ff ff ff £ff £f £ff ff £f £f £f ff ff
ff ff ff £ff ff ff ff ff ff ff ff ff >

£f

Figure 15: Standard Debug View.

NOTE: When simulating, if you would like the simulated clock frequency to match the clock frequency of the
actual uPAD board, select the value listed next to Frequency in the Processor Status window, and enter the

oscillator frequency that you have chosen for your device.

10. Within the I/O view, filter for and select /O Port Configuration (PORTD). (To search for this, you may type

something as simple as “portd” in the Filter textbox, as shown in Figure 16.)
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1=||l=l| Fitter: portd

Value

. 000
-
-
.
000 -
B0 -
000 ~
000 -

.
' C
&) Input/ fig

Figure 16: Filtering I/O View.

11. To execute the next instruction within your program, you can click the Step Into icon as shown in Figure 17.
Step through the program code, identifying changes that occur to the registers within PORTD, as well as to
the microcontroller’s internal GPIO registers.

GPIO_Output main.asm Step Into (F11)

1di ri16, BIT456

PORTD_DIRSET, ri6

Figure 17: Step Controls for Program Debugging.

NOTE: Two other useful debug stepping features are Step Over and Step Out. Step Over will always execute the
next instruction in the current procedure frame as a single unit, i.e., if the next instruction to be executed consists
of a procedure call, the entire procedure will be executed in a single step. Step Out executes the remaining lines of
a function in which the current execution point lies.

We will now stop debugging and begin to running the program on the uPAD. To stop debugging, you can navigate
to Debug = Stop Debugging, or click on the Stop Debugging icon, i.e., the red square, in the toolbar.
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Running the Program in Hardware

1. Connectthe uPAD to your computer with your USB A/B connector cable. Select the on-board Atmel Embedded
Debugger (EDBG) as the Selected debugger/programmer, within the project Tool menu, as done in Step 3 of
the Simulation section. Also verify that the Interface is chosen to be PDI (as shown in Figure 18). Finalize
these changes by saving the project.

ﬂ GPIO Cutput - AtmelStudio Advanced Mode Y Quick Launch (Ctrl+Q) P - B X
File Edit View VAssist{ Project Build Debug Tools Window Help

e - B-ra-oRH b Bl Debug - - B - RecEHBE-_ - el 0

T > W Hex % @~ - L S ] i W ATxmega128ATU § PDI on EDBG (ATMLEDBGC00000000110)
OOTB uPAD 2.0 - 0110 GP\OﬁDutput # X -
Build N/A N/A

Build Events

Toolchain
éﬁﬁ(e_ Selected debugger/programmer

{EDBG - ATMLEDEGCD0000000110 . pDI
Components ] Vi Interface:

PDI Clock

4 MHz

Programming settings

Erase entire chip

Preserve EEPROM

Figure 18: Selecting the on-board uPAD debugger.

NOTE: The PDI (Program and Debug Interface) clock frequency is only representative of the
programmer/debugger, not the microprocessor. It is recommended to leave the default value.

2. Ifthe EDBG device does not appear as shown in Figure 18, there are a few possiblities to correct this problem.
e If you are CONVINCED that you properly followed the install directions, uninstall it, turn off your
antivirus, reinstall it, & turn on antivirus.
e Use the Device Manager to remove some extra drivers that altered the USB function through Microchip
Studio. The procedure can be found at https:// www.microchip.com/forums/m1087470.aspx.

3. Repeat step 6 in the previous section. The code will now be executed on Microchip hardware rather than through
software on your computer. Upon stepping through the program, you should see the RGB LED package at the
bottom left of your uPAD (labeled D4) reflect the changes made to PORTD within the program. These LEDs
are connected to PORTD of your processor, as shown in the uPAD v2.0 Schematic.

NOTES ABOUT MEMORY WINDOW

e The memory window can show either internal Program Memory and internal RAM (Data Memory). To view
Program Memory, select prog APP _SECTION immediately following the Memory: and select data
INTERNAL SRAM for viewing RAM in Data Memory. Immediately, following Address: put the first address
that you would like to view (without changing the ,prog or ,data that will already be to the right of the address).

e Note that it is a window to look at individual bytes. Therefore, when viewing Program Memory, the specified
Program Memory address has been shifted one bit to the left with the least significant bit of 0 corresponding to
the least significant byte of the Program Memory word and the least significant bit of 1 corresponding to the
most significant byte of the Program Memory word. This is because program memory is word addressed.

e The memory window does NOT work for external addresses! Do NOT depend on it.


https://www.microchip.com/forums/m1087470.aspx
https://mil.ufl.edu/4744/docs/uPAD/schematics/uPAD_v2.0_schematic.pdf
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APPENDIX A: SPECIAL CONSIDERATIONS FOR PROJECTS USING C

Microchip Studio cannot work accoss networks without using a network drive. Below are instructions on how to
create a network drive, for Windows 10 and versions prior.

Setting Up A Network Drive For Microchip Studio

Windows 10 and 11:

Type Windows-E (i.c., hold down the windows key and then type E) to open and Windows Exporer
In Windows Explorer, select This PC

Select Computer - Map network drive

Select a drive letter, e.g., Zs:

Put the path to the folder that you want to use, e.g., \\mil.ufl.edu\tebow\4744\labs\

Select Reconnect at sign-in

Select Finish

re-Windows 10:

Type Windows-E (i.e., hold down the windows key and then type E) to open and Windows Exporer
In Windows Explorer, select This PC

Select Map network drive

Select a drive letter, e.g., Z:

Put the path to the folder that you want to use, e.g., \\mil.ufl.edu\tebow\4744\labs\

Select Reconnect at logon

Select Finish

NV AWND =g NN AW~

Procedure to Create, Simulate, and Run Programs in C

1. Open Microchip Studio, and create a new project by navigating to File > New - Project.

2. Under Installed, under the C/C++ subheading, select GCC C Executable Project.

3. Find the path to the proper location with the Location textbox. If necessary, put in the network drive (e.g., Z:),
and then the correct folder name.

4. Create the project by clicking OK, and perform everything else as specified in the above tutorial. The only new
limitation might be that to be able to completely step through a C program, the compiler’s optimization level
may need to be changed. (Optimization allows your compiler to interpret your written C code and attempt to
generate more efficient assembly/machine code, i.e., some C statements written in your program might be
removed by the compiler if any level of optimization is enabled.)

o To turn off optimization, first navigate to Project = <Project Name> Properties. Within the project
properties window, select the Toolchain subheading. Under AVR/GNU C Compiler in the Toolchain,
select Optimization. Within the Optimization window, select the drop-down box for Optimization Level,
and choose Norne (-00). There is now also a Debugging compiler option; for this you can leave it alone.

NOTE: Details for each optimization level specified by the AVR/GNU C Compiler can be found in the

Microchip/Atmel Studio 7 User Guide.



https://www.microchip.com/content/dam/mchp/documents/atmel-start/Atmel-Studio-7-User-Guide.pdf
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